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2 Introduction

The Account Management Tool provides a central point to administer accounts and users and track print, copy and scan usage
for several AccXES based printers. The Account Management Tool application runs on a Windows PC, or a Solaris workstation.

Beginning with AccXES firmware version 7.5, the media usage (job accounting) of multiple printers is tracked through the
Account Management Tool (AMT), or some other external accounting server. This replaces the functionality of the AccXES
Client Tools (ACT) Accounting Tab, which becomes disabled when ACT is communicating with a printer that is using AccXES
firmware version 7.0, or greater.

WARNING: [t is critical to first save media usage data from the printers’ controllers before loading version 7.0 or greater
AccXES firmware, or the data will be lost.

The pre 7.0 AccXES firmware accounting data can be saved by using one of the following techniques: the pre-7.0 Web PMT
Accounting page, the AccXES Client Tools" Accounting Tab, the individual DST that existed prior to the AccXES Client Tools, or
the data can be saved to a floppy disk. See Appendix 1 in the AccXES Account Management Tool Administrator’s Guide for
details.

2.1 How the Account Management Tool Works

Read the Overview and try the Tutorial in the AMT help files in the AccXES Account Management Tool Administrator’s Guide.
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2.2 Installing AMT

It is recommended that the AMT should be installed on only one workstation. Both the AccXES Client Tools and the Account
Management Tool can be installed during the same installation process. A password is needed for installing AMT. If a
password is not entered on the “Enter Password” screen, the “NEXT” button is pressed to continue with installing only the
AccXES Client Tools. See the Read Me file, or the AccXES Account Management Tool Administrator’s Guide for installation
details.

NOTES:

e Because of the additional media types, AMT 11.0 cannot load the previous version’s (v8.0) TALLY tables. The tallied
database can be regenerated from the Raw Job Accounting Database. However, if you want to preserve your current
Tallied Database, you must save it to disk (with a unique file name) before installing AMT 11.0.

e If you want to install another language version of the ACT- AMT application to the same directory, you must first
uninstall the existing ACT- AMT application.

2.3 Microsoft Windows Vista Installation Notes

By default, Windows Vista will virtualize all attempts to write in "C:\Program Files\AccXES\" to
"C:\Users\<CurrentUser>\AppData\Local\VirtualStore\Program Files\AccXES\".

It is possible to access these files without changing any settings by simply typing the location in to the Windows Explorer
location bar. The "AppData” folder is a hidden folder, so it can not be browsed to by clicking through with the mouse unless
Hidden Files and Folders are shown.

This is a new security policy in Windows Vista that falls under User Accounts Control(UAC). The security policy can be found
and modified at:

Control Panel->Administrative Tools->Local Security Policy->Local Policies->Security Options->
The two Security Policies that need to be changed are:

User Account Control: Run all administrators in Admin Approval More
User Account Control: Virtualize file and registry write failures to per-user
locations

If both of these policies are set to disabled before AMT is installed for the first time, then the database files will be written to
the normal location at C:\Program Files\AccXES\AMTdatabase. (The system MUST be restarted before changes to these
policies will take effect)

To switch to this behavior after AMT has been installed and used, you will needto back up the database files then completely
remove AMT. Next, change the security policies, and reboot the system. You can then install AMT, and copy your database files
to the normal location.
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2.4 Uninstalling AMT

Both AMT and ACT are uninstalled at the same time if they reside on the same workstation. In Windows, they are removed by
selecting “AccXES” on the Add/Remove Program Properties screen. In Unix, they are removed in the AccXES/UninstallerData
directory. To preserve your current AMT raw job accounting database, the data files will remain in the AMT database folder
after the uninstall. This database folder will be listed on the Uninstall Complete screen. The .lib and .bin files that also appear
on the Uninstall Complete screen are erroneously listed. This is because they have already been deleted in a previous step of
the Uninstall. See the AccXES Account Management Tool Administrator’s Guide for details on uninstalling AMT.

Uninstalling on Mac OS X: In cases where AMT has been installed on Mac OS X with aliases (shortcuts) located on the Dock,
uninstalling AMT may not remove the alias from the Dock. Simply drag the alias to the trash to complete uninstalling AMT.
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3 What’s new in 12.7 AMT

3.1 Vista Support

Beginning with 12.7 AMT is validated and supports both 32-bit and 64-bit versions of Microsoft Vista.

3.2 IPv6 Support

AMT will now allow you to specify printers using IPv6 addresses and names of IPv6 devices.
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4 Release Notes

4.1 Memory Requirements for Global Associations

The maximum number of AMT records allowed is: 9999 accounts, 9999 users, 999 printers, and 12,000 associations. An
association is a combination of an account, a user, and a printer.

NOTE : If you are running AMT under Microsoft Windows and you plan to utilize the maximum number of associations, you
must set the virtual memory on your system to a starting minimum value of 300 MB.

If AMT is going to reach its associations limit, a popup message will warn you that the associations cannot be created. You
could then delete unused or obsolete accounts, users, or printers in the database to reduce the number of associations as well
as the associations themselves. When an account, user or printer is deleted, any associations that reference that
account/user/printer are deleted.

AMT on Mac OS X: When using this combination it is recommended that you have a minimum of a G4 processor with Panther
10.3.3 or greater and Java 1.4.2 or greater. The Panther and Java updates are available via Apple’s Software Update.

4.2 Printers Tab — Purge Needed Checkbox

If you press the button on the Printers Tab to resend the “purge” command to the printer, the checkbox may remain in the
Purge Needed column. If so, select View > Printers to reset the checkbox to be blank, which indicates that the data was
successfully purged in the printer’s controller job log file.

4.3 Tallied Data

e Using 256 MB of memory, tallying the database could take up to 1 hour if there are 10,000 associations.

e Because of the additional media types, AMT 11.0 cannot load the 8.0 version’s TALLY tables. The tallied database can
be regenerated from the Raw Job Accounting Database. However, if you want to preserve your current Tallied
Database, you must save it to disk (with a unique file name) before installing AMT 11.0.

e For certain large databases, the Generic Account does not get sorted correctly and ends up in the middle. The rows
above and below the Generic Account row are sorted correctly.

4.4 Saving Data to a Disk

When the tally or raw data is written to disk, if a file of the same name already exists an alert pops-up and says: " Do you want
to replace existing file?" Instead of replacing the file, it appends to the existing file. Give each file a unique name to avoid this.
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4.5 One Location for AMT

It is best to use just one AMT application, from one machine. If you try to run more than one AMT application at the same
time, from the same machine, both applications will lock up. If AMT is loaded on more than one machine, then you risk loosing
data if you interact with the same printer from the multiple AMT locations.

4.6 Data Corruption

It is important to do a manual backup of the AMT database files on a regular basis. The names of the AMT database files are:
AccXESjadb.backup, AccXESjadb.data, AccXESjadb.script, AccXESjadb.properties. In the Windows environment, the default
location of these data files is C:\ Program Files \AccXES\ AMTdatabase. If you accidentally corrupt or delete the saved AMT
data files, they cannot be recovered. Your manually backed up files would then need to be copied into the AMT database
folder.

4.7 Importing data

Pre 7.5 AccXES generated data:
e Theimport data file must be a .txt file.

e Scan to net area Legacy accounting data cannot be imported. This is because it is in square area that was scanned
(dm), while the new job based accounting displays scan to net data by file size (KB).

e When importing Legacy accounting data, all printer names will be listed as UNKNOWN.

4.8 Non-AccXES Controller generated data:

AMT will only import an ASCII text format file containing account and sub-account/user identifiers, no binary code, and no
control characters except CRLF (Carriage Return Line Feed). See the Import section of the user guides for details of the
acceptable format within the ASCII file.

NOTE: In AMT 8.0, if account or sub-account identifiers were greater than 32 characters, the first 32 were imported.
Beginning with 9.0, these identifiers will not be imported at all. They will be reported as errors.

4.9 Data values

If "metric units” is selected as the Display Units on the Job Accounting Options dialog, the raw database units are square mm
and become square dm in the tallied database. If "english units" is selected, the raw database units are square inches and the
tallied data is in square feet.

In the raw database, which shows on the Printer Job Accounting Tab, if multiple media sizes, or media types, are used for the
same print job, the data for only one shows in the Media Type column cell. It is the first value read from the AccXES
controller’s job log file. The AMT has no control over the order in which the AccXES populates the job log file. However, you can
double click on the Media Type table cell to reveal the data values for all of the media types that were used in the same print
job.
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4.10Exporting Data

After exporting the raw or tallied data, the same data will be exported during the next export of data, if the records are not first
deleted from the databases, via the Printer Job Accounting Tab. You should also export data before the Raw Job Accounting
Database’s keep interval (default 30 days) is reached, which will cause the raw database records to be deleted the next time
that you retrieve data from the printers’ controllers.

4.11Data Records Retrieved from Deleted UserIDs or AccountIDs

It is recommended that the AMT Administrator retrieve the printer controller’s job log file data first before deleting users or
accounts in the AMT. If not, the existing job log file data will still be copied to the AMT Raw Job Accounting the next time that
you retrieve data from the controllers.

4.12Displayed Records Disappear

When displaying the database records, either raw or tallied, they will seem to disappear if the ‘Job Accounting Options’
dialogue is opened.

To re-display the records simply press either the ‘view’ or ‘view tallied’ button.

4.13 Miscellaneous

e If you want to install another language version of the ACT- AMT application to the same directory, you must first
uninstall the existing ACT- AMT application.

When a user specifies that a job be folded, the job is logged as "Folded" even if the fold job does not complete the fold
process.

414 Unix and GNU/Linux

Default Shortcut Location

The default shortcut location is the home directory for Solaris and Linux. If you want to create a shortcut to a specific folder,
when prompted to do so during the installation process, be sure that the folder exists. If it doesn’t, although the installation
will be successful, the shortcut will not be created because the folder doesn’t exist. Also, make sure that you have permissions
to install in the desired location.
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Shading can cause AMT to freeze

Using the Window Shade feature on an AMT window can cause the application to freeze. The operating system is not
affected, and the application can be closed and restarted to correct the problem.

Serial port not supported w/Linux

The serial port option is not supported on GNU/Linux installations even if the hardware is present. Parallel port and Ethernet
should be used as alternatives.

Installation error using OpenSUSE and Ubuntu GNU/Linux platforms

Verify the latest patch set has been applied to the workstation prior to installation. The following error is invoked when running
the installer on the and OpenSUSE (10.3) and Ubuntu (7.10) platform. This error is purely informational and is regarding the
installer VM.

Launching installer...

libxchb: WARNING! Program tries to unlock a connection without having acquired a lock first, which indicates a programming
error.

There will be no further warnings about this issue.

libxcb: WARNING! Program tries to lock an already locked connection, which indicates a programming error.

There will be no further warnings about this issue.

Installation error using Fedora GNU/Linux platforms

Verify the latest patch set has been applied to the workstation prior to installation. The following error is invoked when running
the installer on the and Fedora (8.0) platform. This error is purely informational and is regarding the installer VM.

Configuring the installer for this system’s environment...
Launching installer...

Locking assertion failure. Backtrace:

#0 /usr/lib/libxcb-xlib.s0.0 [0xb5613777]

#1 /usr/lib/libxcb-xlib.s0.0(xcb_xlib_unlock+0x31) [0xb56138d1]

#2 /usr/lib/libX11.50.6(_XReply+0xff) [0xb4012f]

#3 /tmp/install.dir.3079/Linux/resource/jre/lib/i386/xawt/libmawt.so [0xb521022¢]
#4 [tmp/install.dir.3079/Linux/resource/jre/lib/i386/xawt/libmawt.so [0xb571eeed7]

... (rest of error truncated for readibility) ....

Use of Desktop Effects

When running the FreeFlow Account Management Tool Desktop Effects must be disabled. The interaction between Desktop
Effects and the Account Management Tool prohibts the use of drop down menus. If driop down menus do not activate during
the use of the FreeFlow Account Management Tool, it is rrecommeded to verify this feature is disabled.

Umlauts

Labels containing umlauts may not print correctly from AMT when running under Linux.
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4,15Mac OS X

Minimum Requirements

When using ACT with Mac OS X it is required that you have a minimum of a G4 processor with Mac OS X 10.4 or greater, Java
1.4.2 or greater, and a screen resolution of 1152x870 or greater. Ignoring these recommendations will result in unreliable
operation of ACT on OS X. The Mac OS X and Java updates are available via Apple’s Software Update.
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